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5300 Call Report Quick Reference  

 
General Steps for all New Call Reports 
 
1. Ensure you have the latest version of the software installed  
 
2. Open the 5300 Call Report Program 
 
3. Start a New Call Report by clicking File and selecting New 
 
4. Select the appropriate form  
 
5. Enter the Charter Name, Charter Number, and Check Digit 
 
6. Choose an applicable Region and State and click OK 
 
7. Complete all applicable tabs 
 
8. Check for Errors by clicking Data from the tool bar menu and selecting Browser 
 
9. Select Errors (The Browser window will appear.  If there are any errors, they will be in 

the left hand column.  Click on the error and the Description box will populate).  
 
10. Correct all errors (if applicable).  All errors must be corrected for a successful 

transmission. 
 
11. Review all Warnings by clicking Data from the tool bar menu and selecting Browser 
 
12. Select Warnings (If there are any warnings, they will be in the left hand column.  Click 

on the warning and the Description box will populate.) 
 
13. If the warning requires a correction, correct the call report.  If a correction is not 

necessary, the credit union is required to provide a comment in the comment box.  All 
warnings must have a comment for a successful transmission. 

 
14. After adding a comment for each warning, click OK 
 
15. Continue using either Credit union uses eSend or Credit union emails the .xml 

file or sends a CD to the Examiner/SSA steps below. 
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5300 Call Report Quick Reference  

 
Credit union uses eSend (**Preferred method – most advantageous for the Credit Union and the 
Examiner/ State Supervisory Authority) 

 
1. Perform steps 1 – 14 under General Steps for all New Call Reports 
 
2. Establish an Internet connection 
 
3. Make sure the call report is open and click Data and select eSend to NCUA 
 
4. The Charter Number will automatically populate.  Enter a Password.   
 
5. Enter an email address to receive the upload confirmation and reports. This email 

address should be that of the primary staff member responsible for preparing the 5300 
call report.  Click OK 

 
6. An eSend Data window will appear.  If the upload is successful, it will say “OK – Your 

request uploading Call Report [date] for CU [charter number] is in the processing 
queue. – Please check your email later for the result.”  

 
7. If the password is incorrect, you will receive an error message.  If you get an error 

message, repeat steps 3 – 6, otherwise proceed to step 8.  
 
8. Within 24 hours, an email with two attachments will be sent to the email provided in 

step 5 above.  The first attachment has a .txt extension and identifies if the upload was 
successful.  The second is the Historical Warnings Report.  A Financial Performance 
Report will also be emailed within 24 hours. 

 
Credit union emails the .xml file or sends a CD to the Examiner/SSA 
 
1. Perform steps 1 – 14 under General Steps for all New Call Reports 
 
2. Make sure the call report is open.  Click Data and select Export 
 
3. Select a location to save the file (hard drive, CD-Rom, etc).  Note:  Do not save the file 

to a floppy disk.  Examiners no longer have the equipment to read this media.  If you 
are unable to burn to a CD, you may use eSend or email the file to the examiner.  

 
4. To email the .xml file, attach it to the email message.  If mailing a CD to the 

examiner/SSA, send it to the address outlined in the letter sent from NCUA. 
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5300 Call Report Quick Reference  

 
Making Prior Period Adjustments 

 
1. Establish an Internet connection 
 
2. Open the 5300 Call Report Program 
 
3. Click on Data from the tool bar menu 
 
4. Select Download Validated Reports 
 
5. Choose a cycle date and click OK (You can select multiple cycles with the ctrl key) 
 
6. Enter the Charter Number, Password, and Email Address in the Authentication Window 

and click OK 
 
7. Click OK to close the window (The call reports will download directly into the program) 
 
8. Open the call report 
 
9. Make all necessary changes and correct all Errors (Refer to Steps 8 – 9 in General 

Steps for all New Call Reports)  
 
10. Add comments for all Warnings (Refer to Steps 11 – 13 in General Steps for all New 

Call Reports)   
 
11. Save the file 
 
12. Repeat steps 2 – 8 in section Credit union uses eSend or steps 2 – 4 in section Credit 

union emails the .xml file or sends a CD to the Examiner/SSA   
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I. Introduction 
 

a. Data Collection 
 

The 5300 Call Report is the primary means by which the National Credit Union 
Administration (NCUA) collects quarterly financial and operational data for all 
federally insured credit unions (FICUs).  The majority of the collection is public 
data and is available for review and download on the NCUA website at 
http://www.ncua.gov.  NCUA regularly reviews the type of data collected on 
the call report and makes adjustments as necessary to reflect the increasing 
sophistication of credit union products and services and the changing 
regulatory environment.   

 
The design of the call report eases the burden of reporting on small credit 
unions.  The Form NCUA 5300 was revised for the June 30, 2006 call report 
cycle to consolidate information and reduce ancillary schedules.  The report 
was reduced from nineteen to sixteen pages and reorganized so only the first 
ten pages require input from all credit unions.  As well, the number of ancillary 
schedules was reduced from seven to three.  Credit unions that engage in a 
broader range of investment, share, or lending activities must complete the 
supplementary schedules as needed.  The 5300SF for credit unions with 
assets less than $10 million is no longer available.     
 
NCUA provides internally developed software to all FICUs for use in preparing 
their quarterly data submission.  The software contains auto sum features and 
data entry controls to help minimize errors in reporting.  When data entry is 
complete, the user creates a transmission file to transfer the data to NCUA.  
Alternatively, a credit union may submit their call report data on the hardcopy 
form NCUA provides to all FICUs quarterly.   

 
b. Data Transmission 
 

If a credit union uses the NCUA provided software for data submission, they 
may transfer the data file in one of several ways.  One way is to save the 
transmission file to a compact disk (CD) and mail the CD to their NCUA 
examiner or State Supervisory Authority (SSA).  Another way of transferring 
the data is to save the transmission file on their local hard drive and e-mail it to 
the NCUA examiner or SSA.  In either of these cases, the NCUA examiner or 
SSA imports the transmission file into their call report program to make it 
available for review and upload. 
 
The final and most advantageous way for a credit union to transfer the data file 
to their NCUA examiner or SSA is to use the eSend feature contained in the 
software.  As shown in Figure 1, this feature allows the credit union to transfer 
the data file via the Internet to a processing server located at NCUA.  Once at 
the server, the data runs through an electronic validation process that 
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compares current cycle data to historically reported data to identify unusual or 
unlikely conditions.   
     

 
 
The server produces a Historical Warnings Report (HWR) listing unusual or 
unlikely conditions.  As shown below, the NCUA examiner or SSA receives a 
copy of this report and a Financial Performance Report (FPR) with the 
transmission file for review.  The credit union using eSend receives a copy of 
the HWR and FPR via email.   
 

 
 

c. Data Reporting 
 

NCUA prepares Financial Performance Reports (FPR) for all federally insured 
credit unions (FICUs) each cycle.  FPRs contain summary financial and 
statistical data, calculated financial ratios, peer averages, and graphs.  NCUA 
delivers the FPR electronically within 24 hours of the initial data submission to 
all FICUs using eSend.  This version of the FPR contains five pages:  
 

1. Summary of Financial Statement;  
2. Ratio Analysis;  
3. Assets;  

Credit 
Union 

Transmission 
File (XML) 

Figure 1

Process Server 

Figure 2

FPR 

Historical 
Warnings 

Report 

Credit 
Union Examiner/

SSA 

Transmission 
File (XML) 

 Process Server 
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4. Liabilities, Shares & Equity; and  
5. Income Statement.   

 
Also, this version contains peer averages for the prior cycle only.  At the end of 
the cycle, NCUA calculates current cycle peer averages and distributes FPRs 
containing current cycle peer averages to all FICUs either electronically or 
through the U.S. Mail.  FPRs for all FICUs are available to the public by 
request from the NCUA website.  NCUA also posts files containing industry 
data in plain text (ASCII) format that is suitable for importing into a database or 
spreadsheet for review and analysis. 

 
II. Software Features 
 

a. System Requirements 
 

The minimum system requirements to install and run the 5300 Call Report 
software include: 
 
• IBM compatible Pentium 90 or higher computer 
 
• Windows 98, Windows NT, Windows 2000, Windows ME, or Windows XP 
 
• 24 MB RAM minimum for Windows 98; 32 MB RAM minimum for 

Windows NT, Windows 2000, Windows ME, or Windows XP 
 
• CD-ROM drive 
 
• Microsoft Internet Explorer (Version 5.5 or higher) 
 
• 2 megabytes of free hard drive space  
        (if installing Internet Explorer an additional 45 MB is required) 
 
• 3.5 inch floppy high density disk drive 
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b. Installation 
 

To install the 5300 Call Report software: 
 
1. Insert the 5300 Call Report CD into the CD drive.  A menu, as below, will 

pop up. 
 

 
 
2. Click on the Install Call Report button.  An InstallShieldWizard window, as 

below, will pop up as the program prepares to install the necessary files. 
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3. Next, a Windows Installer message, as below, will appear. 
 

 
 
4. The InstallShield Wizard for the NCUA Call Report, as below, will appear.  
 

 
 
5. Follow the instructions on the screen to install the software. 
 
6. The installation procedure will install an icon, as below, on the Desktop.  

 

    
 

Please note: some operating systems may require the user to restart the 
computer during or after the installation process in order for the icon to appear 
on the Desktop. 
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c. Getting Started 
 

To start the 5300 Call Report Program: 
 
1. Double click on the NCUA Form 5300 Desktop icon (as above) or 
  
2. Click on Start, select Programs and click on NCUA\Call Report\Call Report.  

This will launch the program’s Home Page. 
 

 
 
The Home Page contains a link to start or continue a form.  The tool bar above 
it provides access to all available software functions. 
  

d. Tool Bar Items 
 

1. The File menu on the tool bar contains menu items that allow the user to: 
 

• start a New call report; 

• Open, Save, Print, and Close an existing call report;  
 

• Convert from short form to standard form; and 

• Exit the program. 
 

 
 



A Users’ Guide to the 5300 Call Report Software 
 

   13 

 
2. The Data menu on the tool bar contains menu items that allow the user to: 

 
• Browse through a list of Accounts, Errors or Warnings; 

• Toggle on and off an option to Highlight Errors; 

• Import and Export transmission files; 

• eSend to NCUA a transmission file; and 

• Download Validated Reports for review and correction. 
 

 
 
 

3. The Help menu on the tool bar contains menu items that allow the user to: 
 

• Search the Contents for applicable help topics; 
 
• Link to the NCUA website for 5300 Online Support; and  

 
• Determine information About the software.   

 

 
 
e. Data Entry Controls 
 

The 5300 Call Report software contains auto sum features and data entry 
controls to help minimize errors in reporting.  Errors and warnings are two 
types of data entry controls programmed into the software.   
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Errors 
 
Errors identify data representing conditions that cannot be true (e.g., assets do 
not equal liabilities plus equity).  Controls in the software prevent the creation 
of a transmission file for a call report containing errors.  The Error Browser 
under the Data menu of the tool bar displays a list of all identified errors.   
 
As shown below, the Browser feature produces a pop up window containing 
the identification number of the error, a description of the error, and the 
page(s) containing the erroneous data.  The Go to Page feature allows the 
user to jump to the appropriate page(s) to correct the error.   
 
The comment box is grayed out in the Error Browser.  In this case, a comment 
is not required because all errors must be resolved before creating a 
transmission file.          
 

 
 
Warnings 
 
Warnings identify data representing conditions that can be true but are 
generally outside expected parameters (e.g., the amount of recoveries on 
loans charged off is greater than the amount of loans charged off).    Since 
warnings represent conditions that may be true, the software does not prevent 
the creation of a transmission file for a call report containing warnings.  
However, a comment describing the conditions leading to the warning is 
required.  The Warning Browser under the Data menu of the tool bar displays 
a list of all identified warnings.   
 
As shown below, the Browser feature produces a pop up window containing 
the identification number of the warning, a description of the warning, and the 
page(s) containing the data causing the warning.  The Go to Page feature 



A Users’ Guide to the 5300 Call Report Software 
 

   15 

allows the user to jump to the appropriate page(s) to view the data causing the 
warning.   
 
The comment box is active in the Warning Browser.  In this case, a comment 
is required for all triggered warnings before creating a transmission file.          
 

 
 

 
III. Using the Software 
 

a. To start a New call report: 
 

1. Click File on the tool bar menu and select New or click the link on the 
Home Page.  A Start a Call Report window will pop up, as shown; 

 

 
 

2. In the Form dropdown menu of the window; 
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3. Enter the Charter Name, Charter Number, and Check Digit; 
 
4. Choose the applicable Region and State from their respective drop down 

menus; and 
 
5. Click the OK button.  A pop up window, as below, will appear for a few 

seconds while the program initializes a new report and loads the accounts.   
 

 
 
b. To Open an existing call report: 

 
1. Click the link to the applicable call report from the Home Page; or 
 
2. Click File on the tool bar menu and select Open.  A Select a Call Report 

window, as below, will pop up.   
 
3. Select the applicable call report and click the Open button.  A pop up 

window, as above, will appear for a few seconds while the program 
initializes a new report and loads the accounts.   
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c. To Navigate a call report: 

 
1. To navigate from page to page when a call report is open, click on the tab 

representing the applicable page number at the top of the screen.  An 
alternate way to navigate from page to page is to depress the control (ctrl) 
button with the page up (pg up) or page down (pg dn) buttons.  

 

  
 

2. To navigate from data entry field to data entry field use the tab key or down 
arrow key.  Fields that are shaded gray are calculated fields and require no 
input.  Data entry fields are white or pink.  Pink fields indicate the 
applicable field is a piece of data causing an error or warning to be 
triggered.  Data entry controls require a user to enter whole numbers in all 
fields.  

 
d. To Close an existing call report: 

 
1. Click File on the tool bar menu and select Close.  A Save Work First 

window, as below, will pop up.   
 

 
 

2. Click the Yes button to save changes and close the file or click the No 
button to close the file without saving changes or click the Cancel button to 
continue working on the call report. 

 
e. To Save a call report: 
 

1. Click File on the tool bar menu and select Save; and 
   
2. Continue working on the call report. 

 
A pop up window will appear briefly indicating the program is saving the file. 

 
f. To Delete a call report:  
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1. Click File on the tool bar menu and select Open.  A Select a Call Report 
window, as below, will pop up.   

 

 
 
2. Select the applicable call report and the Delete button will activate.  Click 

on the Delete button.  A pop up message, as below, will appear questioning 
the action. 

 

 
 

3. Click the Yes button to delete the call report or click the No button to cancel 
the action. 

 
g. To Exit the program:  

 
1. Click File on the tool bar menu and select Exit or click on the  in the 

upper right hand corner of the window.  A Save Work First window will pop 
up if changes were made since the last time the file was saved.   

 
2. Click the Yes button to save changes and exit the program or click the No 

button to exit the program without saving changes or click the Cancel 
button to continue working on the call report. 

 
h. To Browse for an account, error or warning: 

 
1. Click Data on the tool bar menu, select Browser and Account, Error, or 

Warning, as applicable.  A Browser window, as below, will pop up. 
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2. Click on a selection in the left hand menu.  The description box will 
populate with a description of the account, error or warning, as applicable.  
The comment box will only be active in the warning browser.  A comment 
must be provided for every warning.  The Found on Page(s) dropdown 
menu will include a list of the pages containing the account, error or 
warning. 

 
3. Click on a page number in the dropdown menu and click the Go to Page 

button to navigate to the page containing the questionable data and make 
any necessary corrections.   

 
4. Click on the Print button to print a report of all accounts, errors or warnings, 

as applicable.  The report of warnings will include a list of the comments 
provided in the comment box. 

 
i. To Import a file: 
 

The import option allows a user to import a transmission file that is saved on 
the hard drive or on disk.  Examiners will use this option to import a 
transmission file forwarded by a credit union either on disk or via email.  All call 
reports must be closed in order to import a file.   

 
1. Click Data on the tool bar menu, select Import.  A Select a Transmission 

File to Import window will pop up.  Please note if a call report is open, the 
Import option will be grayed out.   

 
2. Browse to the directory containing the transmission file to import, click on 

the file name and click the Open button. 
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3. If the call report already exists in the program, a warning message, as 
below, will appear to alert the user the existing file will be overwritten. 

 

 
 

4. Click the Yes button to overwrite the existing file or click No to cancel. 
 

j. To Export a file: 
 

1. Click on Data on the menu bar and select the Export option.  Please note if 
the call report contains errors or if the comment box for any active warning 
is empty, an Action Denied error message will appear, as below.  All errors 
must be resolved and a comment must be provided for each warning 
before creating and exporting a transmission file. 

 

 
 
2. Select a location to export the report.  Click the Save button. 
 
3. A message, as below, will appear when the file is successfully saved.  The 

message will indicate the path where the file was saved including the drive 
letter and file name.  The example below shows the export file name as 
5300Data-#####YYYYYY.XML. The # symbols in the file name represent 
the credit union's charter number and the Y represents the cycle date. 
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4. Save the transmission file to a data disk or hard drive.  The disk containing 
the transmission file may be mailed to the appropriate supervisory 
authority.  Alternatively, the transmission file may be forwarded to the 
appropriate supervisory authority as an attachment to an email or via the 
eSend to NCUA option as described in the next section.       

 
k. To send the file using eSend to NCUA: 

 
1. Connect to the Internet via a network connection or a dial-up modem.  If 

using a dial-up connection, connect to the credit union's Internet Service 
Provider (e.g., America Online).   

 
2. Double click on the NCUA Form 5300 Desktop icon to start the program.  

 
3. Click the link to open the applicable call report from the Home Page. 

 
4. Click on Data on the menu bar and select the eSend to NCUA option.   

Please note if the call report contains errors or if the comment box for any 
warning is empty, an Action Denied error message will appear, as below. 
All errors must be resolved and a comment must be provided for each 
warning before using this option.  

 

 
 

5. If all errors are clear and a comment exists for each triggered warning, an 
Authentication window, as below, will pop up.   
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6. The Charter Number will automatically populate.  Enter the credit union’s 

password.  Please note to change the password, follow the instructions in 
the Change 5300 Call Report Password section below. 

 
7. Enter an email address to receive the upload confirmation and reports. This 

email address should be that of the primary staff member responsible for 
preparing the 5300 call report.  Confirm the email address by entering it a 
second time.  Click the OK button when the entries are complete. 

 
The eSend Data window, as below, will display a status message indicating 
the call report was forwarded to a processing queue.  Click the Print 
Confirmation button to send the upload confirmation information to your 
printer.  Click the OK button and wait to receive the results via email.  If the 
eSend to NCUA is successful, it is not necessary to create and mail an 
export file data disk to the appropriate supervisory authority.  

 

 
    

8. If the following message appears, it is an indication that the password 
entered in step 6 is not the correct password. 
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9. If the upload was successful, within 24 hours, an email with two 

attachments will be delivered to the email address provided in step 6 
above.  The first attachment is a file with a .txt file extension, as below, 
containing the following information:  upload timestamp, credit union 
charter number, credit union name, call report cycle date, and status (the 
status indicates the upload was successful). 
 

 
 

The second attachment is a file with a filename like WM05#####[nnn].XLS 
where W represents Warnings Report, M represents the cycle month, 05 
represents the cycle year, the # symbol represents the charter number and 
[nnn] is a long string of numbers.  This file contains the Historical Warnings 
Report described in the Data Transmission section above. 

 
10. The Financial Performance Report, as described in the Data Reporting 

section above, will also be delivered to the email address noted in step 6 
within 24 hours.   

 
l. To Download Validated Reports (for prior cycle corrections) 

 
1. Click on Data on the menu bar and select the Download Validated Reports 

option.  A Choose a Cycle Date window, as below, will pop up. 
 

 
 



A Users’ Guide to the 5300 Call Report Software 
 

   24 

2. Select the applicable cycle date in the list of available cycle dates and click 
the OK button.  An Authentication window, as below, will pop up.  

 

 
 

3. Enter the credit union’s charter number and password.  Click the OK 
button.  A Downloading Call Report window, as below, will pop up.  The 
transmission file will download directly to the program and will be available 
for any necessary modifications.  Click OK to close the window. 

 

 
 

m. To Change 5300 Call Report Password 
 

1. Open Internet Explorer, type in the following Internet address: 
https://webapps.ncua.gov/CUPMS and press enter. 

 
 

2. Click the OK button if a Security Alert warning box appears.  
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3. The Credit Union Password Management page will appear. 
 

 
 

4. In the Select an Application Name: drop down box select the 5300 ---5300 
Call Report option.   
 

5. Input the Credit Union’s charter number and select the Change Password 
option.  

 
6. Enter the current password, new password twice, and click the Submit 

button.  Review the Rules of valid Passwords to ensure the new password 
will meet password requirements. 
 

7. If the password is successfully changed the following message will appear:  
The Password has been changed for this Charter Number: followed by the 
Credit Union’s charter number and name. 
 

8. Remember the new password or write it down and store it in a secure 
place.  The new password may be used immediately.  

 
We have added a series of challenge questions in case you forget your 
password.  The website address for the challenge questions is 
https://webapps.ncua.gov/CUPMS/CUChallengeCA.aspx. 
 
Please take a moment to set up your challenge questions now so you will be 
able to retrieve your password from the system in the event you need to 
access it in the future.   

 
You may also choose to have a lost or forgotten password faxed to the fax 
number on record or emailed to the email address on record. 
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IV. Technical Support Issues 
 

The following is a list of technical issues that may be associated with using the 
NCUA 5300 Call Report software.  The solutions are offered only as a guide.  
Credit union staff are advised to consult with their technical support staff before 
attempting to implement these solutions. 

 
1. Error when installing the NCUA Call Report software: 

 

 
 
 Solution: 
 

The user may need to install the Windows 98 Year 2000 Update 
http://www.microsoft.com/windows98/downloads/contents/wurecommended/y
2k/default.asp and the Windows 98 Year 2000 Update 2 
http://www.microsoft.com/windows98/downloads/contents/WURecommended/
y2k2/Default.asp.   
 
Microsoft identified minor Year 2000 issues within Windows® 98.  These 
updates correct several minor issues associated with generating dates on or 
after January 1, 2000.  Users’ must install the Year 2000 Update before 
installing Update 2. 
 
If the error still exists, the users may try to skip MDAC 2.6 and try upgrading to 
MDAC 2.7, thereby making the NCUA Call Report installation skip its attempt 
to install MDAC 2.6.  To do download and install MDAC 2.7: 
http://www.microsoft.com/downloads/details.aspx?familyid=9ad000f2-cae7-
493d-b0f3-ae36c570ade8&languageid=f49e8428-7071-4979-8a67-
3cffcb0c2524&displaylang=en 
 
After the MDAC 2.7 installation completes successfully, the user should retry 
installing the Call Report software. 
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2. Error when launching the program: 
 

Error Message:  
 
The feature you are trying to use is on a network resource that is unavailable.   
Click OK to try again or change the path. 

 
 Solution: 
 

The user may have tried to install the program on a computer for which the 
user does not have administrative privileges.  If so, even when the program is 
uninstalled and then installed by an IT person with administrative privileges, 
the error still exists.  This is because the registry keys were altered when the 
user originally attempted to install the program.  An IT persons familiar with 
registry keys needs to contact the technical help desk so the technician can 
walk them through the process of deleting the registry key.  

 
3. Error when starting a New call report: 

 

 
 
 Solution: 
 

The user may need to download the latest service pack for the Jet 4.0 
Database Engine.  By default, Microsoft Jet is the database engine that is used 
in Microsoft Access.  This error results if the latest service pack has not been 
installed.  To verify that you have the latest service pack installed for your 
operating system, visit the following Microsoft Web site: 
http://windowsupdate.microsoft.com. 
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4. Error when using Download Validated Report option: 
 

 
 
Solution: 
 
The user may not have at least one language selected within Internet Explorer 
(IE).  To determine if this is the problem, within IE, go to Tools->Internet 
Options, click on the 'Language' button. Ensure that at least one language is 
selected, ex. "English (United States)". 
 
If the error still exists, the user may need to re-install the MSXML library, which 
is the component used to talk to the NCUA servers.  
 

 
msxml.msi
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5. Error when trying to open the Historical Warnings Report: 
 

The naming convention for the Historical Warnings Report (HWR) is 
WM05#####[nnn].XLS where W represents Warnings Report, M represents 
the cycle month, 05 represents the cycle year, the # symbol represents the 
charter number and [nnn] is a long string of numbers.  Due to the long file 
name, the email server may either strip out the HWR or change the file 
extension.   
 
Solution: 
 
If the file is stripped out of the email message, the user can ask the credit 
union’s email administrator to recover the HWR Excel file or ask the examiner 
to forward a copy of the HWR, or resubmit the upload with a different email 
address like hotmail.com or yahoo.com which allows most attachments. 
 
If the file extension was changed by the email server, the user can still access 
the report by saving the file to the hard drive and changing the file extension 
back to .xls.   
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5300 Call Report Process Improvements 
Frequently Asked Questions 

 
1. Must a credit union submit the 5300 Call Report on a CD-Rom? 
 
There are several ways to submit the 5300 Call Report.  The most advantageous way is 
to use the eSend to NCUA option under the Data menu in the 5300 software.  
Alternatively, a credit union may export the 5300 Call Report file and attach the file to e-
mail or save it to CD-Rom.  Finally, a credit union may submit the 5300 Call Report in 
hard copy by fax or mail.   
 
To yield the most benefits, submit the 5300 Call Report via eSend and receive the 
Financial Performance Report and Historical Warnings Report within 24 hours. 
 
2. May a credit union continue to submit the 5300 Call Report manually? 
 
Yes, the 5300 Call Report may be submitted manually; but, NCUA strongly encourages 
credit unions to move toward using eSend.  The benefits of eSend include the more 
timely receipt of an expanded Financial Performance Report (FPR) and Historical 
Warnings Report.  These tools may enhance data accuracy, assist with trend analysis, 
and facilitate communications with the examiner.  Also, the call report software has built 
in subtotals and edit checks that help validate the accuracy of the data.  
 
3. If the call report data triggers an error or warning in the software, will the 5300 

software program highlight the particular item causing the error or warning? 
 
Yes, the data elements that trigger an error or warning are shaded in pink to help identify 
the data source triggering the error or warning.  Please refer to the Error Browser or 
Warning Browser for specific details to assist in correcting an error or warning. 
 
4. Will state chartered credit unions be able to use eSend? 
 
The software and process is the same for federal and state chartered credit unions.  
NCUA will not programmatically prevent a state chartered credit union from using eSend; 
however, some State Supervisory Authorities (SSAs) may have a policy that prohibits 
their state chartered credit unions from using eSend.  NCUA encourages all credit unions 
to use eSend to yield the greatest benefit. 
 
5. If a credit union uses eSend, must they additionally send the 5300 Call Report to the 

examiner? 
 
No, if a credit union uses the eSend option to submit the call report, there is no need to 
send the hardcopy report to the examiner.  The examiner or SSA, as applicable, will 
electronically receive the call report data submitted by a credit union.  The credit union 
will receive an email confirmation to inform whether the eSend upload was successful.  If 
the confirmation email indicates there was an error in the upload, the credit union may 
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need to correct the error and eSend the file again.  If the confirmation email indicates the 
upload was successful, no further action is required. 
 
6. When saving or exporting a file, will the 5300 software program automatically name 

the file or does a credit union create the name? 
 
The program uses a naming convention when saving or exporting the file.  The naming 
convention is 5300Data-XXXXXYYYYQQ where X represents the five-digit charter 
number, Y represents the four-digit year of the cycle, and Q represents the two-digit 
month for the applicable quarter.   
 
7. May a credit union save the file in a format other than the XML format? 
 
No, the software only allows output in the XML format; however, the FPR the credit union 
receives within 24 hours after eSend contains the entire income statement and balance 
sheet, as well as financial ratios, in Microsoft Excel.  The FPR available on request from 
the NCUA website, at the URL noted below, is even more detailed containing most of the 
call report data.  http://www.ncua.gov/data/FprTrans.htm 
 
8. How soon after the credit union submits the call report by eSend will the expanded 

pages of the FPR be available on the Internet by request? 
 
The more detailed FPR information is available immediately after a credit union submits 
the call report using eSend.  Once the credit union receives the electronic 5-page FPR 
via email, they may go to the URL noted in question 7 to request an expanded report. 
 
9. If an SSA required a copy of the financial statements be sent along with the 5300 Call 

Report in the past, is that still a requirement? 
 
NCUA recommends a state-chartered credit union contact their SSA regarding specific 
policies.  At this time, the financial statements cannot be attached to the 5300 Call 
Report file that is submitted using eSend.  However, the statements can be sent to the 
SSA separately through the mail, email, or fax. 
 
10. If a credit union uses eSend, will they receive a hard copy of the FPR with updated 

peer ratios when they are available for the current cycle? 
 
No, a credit union using eSend will not receive a hardcopy FPR; however, NCUA will 
notify all credit unions when the peer ratios for the current cycle are available.  Credit 
unions using eSend may request an updated FPR that includes peer ratios for the 
current cycle via the NCUA Internet site after the cycle is complete.  The new FPR does, 
however, include the prior period peer ratios for informational purposes. 
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11. How soon after the call report date are the current period peer ratios available? 
 
The current cycle peer ratios are available approximately 6 to 8 weeks after the 5300 
Call Report quarter end date. 
 
12. Does NCUA expect board members to understand what’s in the FPR?  Are 

examiners available to explain? 
 
Yes, NCUA expects board members to have an understanding of the credit union’s 
financial statements.  Examiners are available to explain.  Board members may also 
want to review the FPR Guide located on NCUA’s website under Credit Union 
Resources, Guides, Manuals, & Forms, or at the URL noted below.  The FPR Guide 
provides the calculations for all FPR financial ratios.  
 
http://www.ncua.gov/GuidesManuals/fpr_guide/fpr_guide.htm 
 
13. Why would I need to change my call report?   How far can I go back? 
 
A credit union may need to make a prior period accounting adjustment or correct an error 
in a previous report.  With the new 5300 Call Report software, a credit union can makes 
changes back to September 2002.  If a change to a call report prior to September 2002 is 
required, the credit union should contact their NCUA examiner or SSA to assist with the 
adjustment. 
 
14. Does the NCUA examiner or SSA have to validate a 5300 Call Report submitted via 

e-Send before the data is available for a credit union to request the expanded FPR 
via the Internet? 

 
No, although all call report submissions must be validated by an NCUA examiner or 
SSA, the expanded pages of the FPR are available for request upon initial upload.  
Having these pages available immediately provides the framework for the credit union to 
review the data submission for errors or omissions and to analyze trends.  The FPR is 
now a dynamic reporting tool, which means that, in the event a correction is made to the 
reported data, the FPR is updated to reflect the most recent information submitted.  
 
15. The call report has numerous gray cells that do not accept data entry.  Why? 
 
Gray shading on data entry fields indicates the fields are calculated accounts.  
Calculated accounts either flow from another page of the call report or are produced 
through a calculation such as summing a column or row of data.  Once all required 
schedules are compete, these cells will automatically populate. 
 
16. Where can a credit union find their password to use eSend? 
 
The initial password is on the bottom left hand corner of the letter that was sent with the 
call report information for December 31, 2005.  Credit unions can manage their password 
through NCUA’s password management system at https://webapps.ncua.gov/CUPMS.  
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https://webapps.ncua.gov/CUPMS.  From this site credit unions can retrieve forgotten 
passwords as well as change their password. 
 
17. Is a credit union required to respond to the Historical Warnings Report? 
 
The Historical Warnings Report is for informational purposes only.   It may help a credit 
union identify errors, trends, potential problem areas, or items an examiner may call to 
discuss.  There is no requirement for a credit union to respond to the report. 
 
18. How soon after using e-Send will a credit union receive confirmation of a successful 

upload? 
 
A credit union will receive conformation of a successful upload within 24 hours to the e-
mail address provided by the credit union during the eSend process. 
 
19. How many cycles back does the Historical Warnings Report go for comparison 

purposes? 
 
The Historical Warnings Report compares data from the current cycle to historically 
reported data.  The time periods that are compared vary for the different types of 
warnings but the maximum is a comparison for twelve cycles back. 
 
20. Does NCUA make the call report software available to information technology 

vendors? 
 
NCUA provides the call report software specifications on the NCUA web site at 
http://www.ncua.gov/data/5300/5300schema.html.  Vendors may use this schema to 
program their software to prepare files to import data directly into the 5300 Call Report 
software. 
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